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Introduction

With the introduction of Windows 8 Microsoft relies on the tiles concept for structured visualization of programs,
apps and information on the home screen. Even SAP has taken up this idea, and with SAP Fiori, they have created
a simple user interface that is build on this tile concept - adapted to the needs of operational business applications.

It was therefore obvious for us to develop a tile solution for Business Intelligence (BI) — the more so as our
customers have signalled a demand. They wanted a start screen for dashboards that clearly represents the key
performance indicators (KPIs).

From this highly aggregated view the user should jump — in terms of a pre-defined navigation path — on graphical
overviews or detailed table views created with our graphomate charts and graphomate tables — see Figure below —
from starting point to detalil
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After a first gathering of the customer requirements pertaining to a tile solution it was obvious that there is no single
tile that can be used for all purposes: too different were the demands on the visual requirements. The solution had
to be a modular construction kit, which allows users to combine different tile modules on a pre-defined layout.

The question remained how to create a uniform design of these modules and the whole tile. Here we were able to
draw on the great work of John Armitage: his design proposals for analytical tiles were our aesthetic standard for a
consistent style. For further reading take a look at his book “Bringing Numbers to Life: Lava and Design-Led
Innovation in Visual Analytics”.

© In the sense of a uniform language regulation we speak in the further manual of Lumira Designer or briefly
Designer.

For our graphomate tiles extension Lumira Designer >= 2.0 SP03 and |IE 11+ are required. For further information,
for example about the deployment on the Business Intelligence Platform (BIP) or SAP Netweaver, please consult
the Product Availability Matrix (PAM). Please note that from 2017, we will no longer support Internet Explorer 9 and
10.
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Installation

e ® Before opening your old dashboards/BI apps with Designer 2.0, you need to migrate them to m mode
with Design Studio 1.6.
® Our extensions for Design Studio 1.6 will also run in Designer 2.0. When starting Lumira 2.0 Designer,
please do not import our graphomate extension from SAP Design Studio 1.6. Instead we suggest
using the versions specifically built for Designer 2.0.

Local installation of the extension to Designer
You have installed Designer 2.0 SP03+ on your computer.

1. Save the zipfile graphomate_tiles_2020.4.x_LumiraDesigner.zip to a folder of your choice.

In Designer, choose Tools Install Extension to Lumira Designer, click on Archive and select the zipfile which
has been saved before.

Choose Finish to start the installation.

Choose Next and again Next to confirm the installation.

Accept the terms of the license agreement and choose Finish.

Choose Yes to allow a restart of Designer.

After the restart, the graphomate extension appears in the Component View of Designer.

n

NoOokw

Removing the extension from Designer
In Designer choose Help > About....

1. Click the Installation Details button.

2. Select the component graphomate tiles 2020.4.x
3. Choose Uninstall... .

4. In the UninstallWizard choose Finish.

5. Choose Yes to allow Designer to restart.
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Server installation of the extension

Users need to deploy the locally installed extension to the Bl platform before launching the graphomate tiles from
the BI platform.

ou

1. Choose in the BI Platform Mode Tools > Platform Extensions.

2. Select the extension graphomate tiles that is installed on your local computer.

3.

4. Manually restart the Bl Platform Adaptive Processing Servers that host the Analysis Application Service and

Choose Install on Platform.

accept the warnings in Designer.
The graphomate extension appears under Extensions Installed on Platform.
Choose Close.

7. Again restart the Bl Platform Adaptive Processing Servers that host the Analysis Application manually.

Uninstalling the extension from the Server

N o

1. Choose in the Bl Platform Mode Tools > Platform Extensions.
2. Choose the graphomate tiles.

3.
4
5

Choose Uninstall from Platform.

. Confirm the uninstalling by choosing Yes.
. In order to complete the uninstalling process, manually restart the Bl Platform Adaptive Processing Servers

that host the Analysis Application Service and accept the warnings in Designer.

The graphomate tiles is then removed from the Extensions Installed on Platform.

Choose Close.

Manually restart the Bl Platform Adaptive Processing Servers that host the Analysis Application Service.
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Quick Start

You have defined a Data Source and now want to depict Data Series from this query with modules of the graphomat
e tiles.

1. Drag the component graphomate tiles to the canvas and bind the Data Source to this component via
drag&drop. Unfortunately, it is only possible to assign one Data Source per tile (as for all Designer
components).

2. Now you can configure your tile on the General/Layout tab: To do this, first select a layout and afterwards
choose the desired modules and drag and drop them to the Builder. The properties for each module are then
generated in the background. You can adjust the properties on the next tab Modules.

3. There you can select via Displayed Dimensions which dimensions and measures from the data source
should be displayed in the modules. This option is strongly related to the chosen module (some modules do
not require the visual display of dimensions).

4. Via the Appearance tab you determine the comprehensive number format for the tile.
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Properties

Basically, you have two ways in which to change the properties of graphomate tiles:
Using the Standard Properties Sheet, that shows all the parameters in a structured list or via the Additional

Properties Sheet. The latter offers a more user-friendly Interface.

The check boxes ' in front of properties in the Additional Properties Sheet are used to control the visibility of
elements and activation of functions. The data source to be used can only be assigned via Drag&Drop to the

component or to the Standard Properties Sheet under Data Binding.

© By pressing the F5 key, both the range of characters as well as the Additional Properties Sheet can be
reinitialized. This is sometimes necessary when changes in the properties are not adopted directly in the

character range.
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General/Layout Tab

Modules

graphomate tiles

Here you can see a list of all currently available modules that can be used to design your tiles. The range of
modules is constantly growing with new releases of the graphomate tiles. A detailed guidance on each module and
its options can be found in the description of the Modules tab.

The Lines Module visualizes trends and thresholds
with two lines.

The Bullet Graphs Module shows up to five bullet
graphs after Stephen Few's concept.

With the Pies Module you can visualize percentages
and a deviation in a pie chart.
The Sparklines Module displays up to ten small,

individually scaled line charts.

The Title Module allows a data-driven definition of
two title lines and an icon.

The Column Module shows up to three columns
with data labels.

The Column Module displays up to three different
measures including category labels and values.

The Footer shows a measure with labels in one line.

The KPI Module visualizes a measure as large
number.

The Legend Module shows up to three items for a
color-based legend.

The Bars Module shows analogous to the Columns
Module up to three bars with data labels.
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The Stacked Column Module shows a data series
as a stacked chart.

The Table Module displays texts and figures in form
of a list.

The Waffles Module displays up to two data series
as a segmented bar chart.

The Slopegraphs Module visualizes up to three
DataCellLists and shows the trend of the ranking of
the individual data points.

The Icon Module displays a single icon.

The Text Module displays up to three lines of fully
HTML capable text.

Layout Config

This switch can be used to select the face of the tile
to be configured.

Each face has its own configuration. This extends to
modules, databinding, layout as well as layout
options. However, only a single data source is
permitted per tile.

graphomate tiles
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General/Layout

Layout Config
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Via mouse click you can choose from currently 24

graphomate tiles

different layouts that consist of up to three lines and
two columns. To set a certain layout just click on the
little grey icon; it then turns blue and the available
layout slots are displayed beneath.

Then simply drag one of the modules above to the
desired row or column of the Builder and drop it
there.

According to the selected module, data connection
and available options are generated in the
background and displayed on the Modules tab.

Please bear in mind that Design Studio allows only
one data source per tile.

Already selected modules can be moved within the L

ayout Builder via drag and drop. Assigned data and
other settings are retained.

Modules can be deleted using the button with the
little x in the top right corner of the module icons.

Layout Display Options Layout Options (Front)

Height of Top Row
Depending on the chosen layout different options .
are available here. R e

. . Ratios First Row
For example, the height ratio of the rows to each

other can be adjusted. (A selection of 1:1:1 results Ratios Second Row
in identical heights of the three rows).)  Divider Lines
For layouts that contain more than one column, Divider Thickness

there is also the option to adjust the width ratio of
the columns to each other. (A selcection of 1:1
results in identical widths of the two columns.)

Module Padding

The option Show Divider Lines activates thin
dividing lines between the rows of the layout.

Adjust the thickness of these dividing lines via Divide
r Thickness.

1 px
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Module Padding allows you to set a uniform
distance that affects each individual module (green Internet A
highlight in the figure on the right shows the default Deviation Act. [ Bud. in 5
setting of 5 pixels). The Padding at this point has no T E—

effect on the dividing lines; for this use the
Component Padding on the Appearance tab (blue \/
highlight).

Net Sales 119.005.872,0,
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Modules Tab

graphomate tiles

© Due to the modular system of a graphomate tile, every datapoint or datalist is andicated with a number. The
numbers of 'dataSingleCellx' or 'dataCellListx"' in your Additional Properties Sheet can differ to the

screenshots in this User Manual. Please be aware.

On this tab, data from the chosen data source can
be assigned to the selected modules. The contents

of this tab is generated from the modules chosen on

the Layout tab.

Due to the dynamic nature of the tiles, the available
script commands to control the behavior of the
modules are generated only after the module
selection.

The script commands can be found by clicking on
the icon. A popup will appear from which the
available commands can be marked and copied
with the mouse. Clicking in the Additional Property
Sheet outside the popup will let it vanish.

By clicking on the dropdown menu, you can choose
the Displayed Dimensions from the metadata to be
used in the module.

Modules Config

Scripting for this module:

-zetSelection('dataSingleCelll”,
'{"Eeyfigures”: "0D NWL IQTY", "0D NWI CHAN™:
mgm1ey;

-gsetModuleProperty(1l, "title"™, "%5BEDIMEHSIOHNS%
L I

-setModuleProperty(l, "subtitle™, "%
SEDIMENSICON1%5Din% SEUONITRSD™) ;

-gsetModuleProperty(l, "boldTitles™, "true™);

-setModuleProperty(l, "absolutelLabelHeight",
"true™};

-setModuleProperty(l, "wrapTitle™, "true");

-gsetModuleProperty(l, "icon™, " [Hone|SAPUILS
Teon|klert|Key Point|Main
Point|Added|RAverage |Change |Correlation|Arrow
Bight|Arrow Upllrrow Down|Harwvey Ball 0%
|Harvey Ball 25%|Harwvey Ball 50%|Harwey Ball
T75%% |Harvey Ball 100%]");

-setModuleProperty(l, "iconColorSelect™,
"[Good Color|Meutral Coleor|Bad Color |Custom
Color]l™);

-setHoduleProperty(l, "customColor™,
"fEEEEEEM]) 7

-setModuleProperty(l, "™uibIconId™, "");

-gsetModuleProperty(l, "horizontalPosition™,
"[Left|Center |[Right]l™}

Displayed Dimensions
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With a click on '™/, you can select data from the
data source to be used with the module. A click on

% will delete the selection.

To easily identify the assigned data property, its
name is displayed in brackets after the dimensions
of the current selection (e. g. dataSingleCell2).

In certain modules (e. g. Title Module, Footer
Module), these can be addressed via a set of
wildcards. The following wildcards are available:

[DIMENSIONS] — shows all dimensions

[DIMENSIONRN] — shows the n-th dimension (up to
DIMENSIONG)

[SCALE] - shows the scaling factor
[UNIT] — shows the unit

[VALUE] - shows the value of a single data cell

dataSingleCell2

Title

Subtitle

Bold Titles

Absolute Label Height
Wrap Title

lcon

lcon Color

Custom Color
SAPUIS Icon Id

Harizontal Position

Title
Subtitle

Net Sales - ACT, West

Met Sales - ACT in kS

graphomate tiles

[¥ | e | ®

[DIMENSIONS]
[DIMENSION1]i

Mone W

MNeutral Colc w

Left w

[DIMENSIONS]
[DIMENSION1]i
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Bar Module

North East 2.06m

Central 10.00m

South East 4.38m

Use the Bar Module to display up to three different measures
including category labels and values. The categories
displayed correspond to the selected Display Dimensions. Scripting Options [#=!

Displayed Dimensions

- 5. Bar Module

Max. Bar Height and Max. Label Height govern the behavior
of the module when the tile is resized; bars and labels will Measures (%  Continent &
scale up to the determined heights in pixels

] S ) dataSingleCell7 ers | X
If the option Absolute Label Height is activated, the labels do ) | =
not scale with the size of the tiles; instead the entry in Max. dataSingleCell8
Label Height is used as the font size. dataSingleCelld ora | X
Scaling Helper will display a help line at the specifiied Scaling hiax. Bar Helght 30 P
Helper Value. Max. Label Height 30 px
Absolute Label Height
Scaling Helper
Scaling Helper Value 0
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Bullet Graph Module

Connechicut
Met Sales

Florida

Met Sales

(Georgia

Met Sales

(=

2m 4m

The Bullet Graph Module corresponds to our graphomate
bullet graphs extension. It is based on Stephen Few's
conceptual considerations regarding the display of KPIs.

A detailed description of all parameters would go beyond the
scope of this chapter. We'd like to refer you to the full
documentation of the graphomate bullet graphs here: de/en.

The following options specifically apply to the graphomate
tiles:

The option Start Element determines the first element in the
assigned data series to be displayed.

The dropdown box Number of Elements governs the number
of bullet graphs to be displayed.

With the checkbox Display Category Labels, the headers can
either be shown or hidden.

Suppress Sums excludes all sums from the selected data
series.

- 2. Bullet Graph Module

Scripting Options [+1
Displayed Dimensions

graphomate tiles

Measures %  Continent

dataCellList1
dataCellList2
dataCellList3
dataCellLiztd
dataCellLists

FPercentage of Lower
Threshold

FPercentage of Higher
Threshold

Start Element
Mumber of Elements
+f Category Labels

Suppress Sums

0.75

1.25

H M| ®| ¥ X
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Column Module

4.38m

2.06m
1.61m

Connecticut  Florida Indiana

Use the Column Module to display up to three different
measures including category labels and values. The
categories displayed correspond to the selected Display
Dimensions.

Max. Column Height and Max. Label Height govern the
behavior of the module when the tile is resized; bars and
labels will scale up to the determined heights in pixels

If the option Absolute Label Height is activated, the labels do
not scale with the size of the tiles; instead the entry in Max.
Label Height is used as the font size.

Checking Scaling Helper will display a help line at the
specifiied Scaling Helper Value.

Category Labels in more than one row are possible with the
option Multi Line Category Labels.

graphomate tiles

b 2. Column Module

Scripting Options 2!
Displayed Dimensions

{ Measures

dataSingleCell2
dataSingleCell3
dataSingleCell4

Max. Column Width

Max. Label Height
Absolute Label Height
Scaling Helper

Scaling Helper Value

Muiti Line Category Labels

[ :\l::

Continent

30
30

100

px
px

16 /42


https://graphomate.atlassian.net/wiki/x/H4CCAw

grapho 1] graphomate tiles

Column Series Module

8.0 5.0
40
America Asia Europe
Use the Column Module to display up to three different = 4. Column Module (Series)
measures including category labels and values. The
displayed categories correspond to the selected Display Scripting Options []
Dimensions. Displayed Dimensions
Max. Column Height and Max. Label Height govern the Measures &  Continent & o
behavior of the module when the tile is resized; bars and
labels will scale up to the determined heights in pixels dataCellList1 vaa | X
If the option Absolute Label Height is activated, the labels do dataCellList2 e | X
not scale with the size of the tiles; instead the entry in Max. Max. Column Width 30 px
Label Height is used as the font size. Max. Label Height 10 o
Checking Scaling Helper will display a help line at the Absolute Label Height

specifiied Scaling Helper Value.
Scaling Helper

If the Multi Line Category Labels option is activated, the

. Scaling Helper Val 100
category labels are wrapped so that they are positioned one caling Relper valus
below the other. Multi Line Category Labels
With Start Element you determine the value from which you Start Element 1
want to display the values from your data source. Mumber of Elements 3 v

With Number of Elements you can specify how many bars
are to be displayed. You can display at least one or a
maximum of five.

© The color of the labels of the integrated deviations
can be changed on the Appearance Tab under Color
Configuration.
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Footer KPI Module

e

Met Sales, California

This module is used to display a single KPI (Measure)
together with its metadata

If an accompanying Comparative Measure is chosen, the
deviation between these two can be displayed, either as
absolute value or percentage. This can be set with the Value
Display option.

You can also use the manual input of values (Manual
Measure and Manual Comparative Measure); these fields
override the values from the data assignment.

The input in Text Input is shown in front of the measure. The
metadata from the data source can be inserted in the text
fields with wildcards; by default all dimensions are displayed
in this module.

The checkbox Increase is Good governs whether positive
deviations will be displayed in red or green.

Units and Scaling Factor will display or hide unit or scaling
factor from the data source.

graphomate tiles

- 5. Footer KPI Module

Scripting Qptions [-]
Displayed Dimensions

res @ | Continent (% | Country & ~
dataSingleCell7 —_
dataSingleCelld can | M

Manual Measure

Manual Comp. Measure

Text Input [DIMENSIONS]
Value Display Measure hd
+f Increase Is Good
+ Units

+ Scaling Factor
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Free Text Module

MNet Sales

12,371,448.0 $

California, West

The Free Text Module shows up to three lines of plain text.
Wildcards can be used to extract and display metadata.

The input boxes Text Line x take one line of text each.

Fontsizes per row can be adjusted with the properties Fontsiz
e Line x.

For bold formatting, the checkbox Bold Titles needs to be
activated.

If the checkbox Wrap Texts is activated, texts exceeding the
space limit will be wrapped, resulting in several lines of texts.
Otherwise, they will be abbreviated with "...".

The dropdown boxes Vertical Position and Horizontal Position
influence the positioning of the text lines within the module.

graphomate tiles

1. Free Text Module

Scripting Options (=]

Displayed Dimensions

Measures (X

dataSingleCell11
Text Line 1

Text Line 2

Text Line 3
Fontsize Line 1
Fontsize Line 2
Fontsize Line 3
Baold Texts
‘Wrap Texts
Vertical Position

Horizontal Position

Continent (% a

First Line

Second Line

Third Line

15 i

15 P

15 px

Top w
Left v
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Icon Module

The Icon Module can be used to depict a single icon. This
can be chosen from 19 predefined SVG symbols or the full
set of SAP UI5 icons.

Use the dropdown box Icon to choose the desired icon.

Icon Color governs whether one of the component-wide
colors a an individually configurable color is used. If "Neutral
Color" is chosen, the "Text Color 2" will be used.

The field SAPUI5 Icon Id allows to insert an icon of the SAPUI5
library, for example, e00a for a synchronize button. To

display the icon, select SAPUIS5 Icon under Icon and write the
Icon ID into the appropriate field.

Max. Size is the maximal size of the icon in px. If the slot is
too small, the icon is reduced in size proportionally.

The dropdown boxes Vertical Position and Horizontal Position
influence the positioning of the text lines within the module.

© Please only use the icons from the namespace sap-
icon:// .

graphomate tiles

- 9, Icon Module

Scripting Options [=]
Displayed Dimensions

Measures (3 Continent

dataSingleCell10
lcon
lcon Color

Custom Color
SAPUIS lcon Id

Max, Size
Vertical Position

Horizontal Position

.x;

Alert

Neutral Colt

50
Center

Center

px

L 4
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KPI Point Module

12.37m;

The KPI Point Module displays a single measure. The size of
the number is scaled according to the available space.

The options correspond largely with those of the Footer KPI
Module; in addition, a Max Font Size can be set. The size of
the displayed number will not exceed the determined font
size.

The checkbox Increase is Good governs whether positive
deviations will be displayed in red or green.

Units and Scaling Factor will display or hide unit or scaling
factor from the data source.

The option Metadata Below Value allows to place the
additional information below the value itself.

The option Show As Percent gives the oppertunity to display
a percentage sign in the size and display form of the units.

The option Replace Null with 0 gives the oppertunity to
replace zero values with a 0, if this is desired.

-

graphomate tiles

4. KPI Point Module

scripting Options EI
Displayed Dimensions

Meuaureaﬂtontmentx\
dataSingleCells *
dataSingleCellG oes || ¥

<

Manual Measure
Manual Comp. Measure
Value Display Measure v
Max Font Size 100 pX
Increase Is Good

Units

Scaling Factor

Metadata Below Value

Show As Percent

Replace Mull with 0
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Legend Module

M Net Sales, California
I Net Sales, Florida
I Billed Quantity, Florida

The Legend Module can be used to display up to three keys
together with the assigned colors.

The keys (Entry 1 to 3) can be either entered manually, or
can be generated using the existing wildcards. If wildcards
are used, it is necessary to assign data first, so metadata are
available.

To hide a key, simply empty the input field.

The colors to be displayed can be defined either with the
dropdown boxes Color Key 1 to 3 (The colors themselves

can be changed on the Appearance tab.). Alternatively you
can choose own colors with the fields Custom Color 1 to 3
(for these colors, choose Custom Color in the fields Color Key

).

The checkbox Bold Text will format the keys in ... well, bold.

The position of the colored squares can be determined with
the option Colored Boxes. If None is selected, no squares
are displayed, but the keys themselves are colored
accordingly.

-

graphomate tiles

9, Legend Module

Scripting Options [er1
Displayed Dimensions

| Measures (®

dataSingleCell13
dataSingleCell14
dataSingleCell15

Entry 1
Entry 2
Entry 3
Color Key 1
Color Key 2
Color Key 3

Custom Color 1

Custom Color 2
Custom Color 3

Bold Text

Colored Boxes

New Entry 1

New Entry 2
MNew Entry 3
Data Color | «
Data Color ;| «

Good Color w

Right w
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Line Chart Module

10.00m

0.00

Jan 08

Do 09

graphomate tiles
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The Line Chart Module allows the display of two data series
as lines (dataCellListx; second value: Secondary Measure)

and an additional Fixed Value (dataSingleCellx), which can

be used as threshold value.

The dropdown box Threshold governs which measure(s)
will be used as threshold value. If a threshold is chosen, the
difference area between Primary Measure and threshold will
be displayed colored. Depending on the selection, either the
differential area between Primary Measure and Secondary
Measure or Primary Measure and Fixed Value is colored.

The thickness of all displayed lines can be changed with the
option Line Size.

If the option Threshold Excess is Good is activated, and a T
hreshold is chosen, the positve difference area is displayed
in green, otherwise in red.

The option Primary Measure as Area turns the chart into an
area chart.

If activated, Value Labels displays the first and last value of
the assigned Primary Measure at the start and end of the
line chart.

Category Labels displays the selected dimensions below
the axis; this options works analogous to Show Value
Labels.

Multi Line Category Labels break a label into several rows.

Value Axis displays a value axis on the left side of the line
chart.

During runtime, Visible Click Handlers displays small circles
around possible jump points, when the mouse pointer
hovers somewhere over the module.

Suppress Sums excludes all sums from the selected data
series. As only one data source per tile is possible, this
option can be useful if the sums are needed in another
module, e. g. the KPI Module.

graphomate tiles

- 1. Line Chart Module

Scripting Options (221
Displayed Dimensions

Measures (= Continent (x)

dataCellList1

dataCellList2

dataSingleCell1

Threshold MNone
Line Size 2

/| Threshold Excess is Good
Primary Measure as Area
+ | Value Labels
Category Labels
Multi Line Category Labels
Value Axis
Visible Click Handlers

Suppress Sums

p
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Pie Module

Met Sales, Apr 09

The Pie Module displays a percentage including a deviation. - 3. Pie Module (Single)

The value for the circle is assigned with the Circle Data option
(datasingleCell17) , Arc Data (dataSingleCell18) is used to
assign the the comparative measure, which is displayed as
circular segment. Deviation Data (dataSingleCell) shows a Measures (%)

Scripting Options [-1
Displayed Dimensions

¥  Continent & e

value as deviation from the Arc Data.

. dataSingleCell17 e | X
The options Category Labels and Value Labels can be used ) ¢
to enhance the graph with metadata from the data source (Ca dataSingleCell18 .
tegory Labels) and exact values. dataSingleCell19 | X
With the checkbox Pos. Deviation is Good, the interpretation | Category Labels
of the deviation can be changed; this way, negative /| Value Labels

deviations can be displayed as positive.
viatl Spiay poSItV + Pos. Deviation is Good
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Slopegraphs Module

Adin Eunog

&80 0
Eurcpe Amarica
50 7.0
AMerica Asia
4.0 8.0

The Slopegraphs module basically corresponds to our
extension graphomate slopegraphs. It visualizes up to three
DataCellLists and shows the trend of the ranking of the
individual data points.

Number of Elements limits the entries to be displayed to a
maximum.

The entry in Start Element determines with which element
the display of the slopegraphs begins. If 5 is entered here,
the first slopegraph is generated from the fifth line, lines 1-4
are skipped.

Suppress Sums excludes any totals in the data source from
the display.

Trend shows the trend of the connecting lines by coloring
them.

Negative is Good inverts the colors of the trend lines.

The thickness of the lines can be set using the Slope
Thickness property.

The Ascending Order option can invert the sorting sequence.

graphomate tiles

- 3. Slopegraphs Module
Scripting Options L1
Displayed Dimensions

Measures

dataCellList10

dataCellList11

dataCellLizt12

Mumber of Elements 5
Start Element 1
Suppress Sums

Trend

Megative iz Good

Slope Thickness 2
Ascending Order

px
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Sparklines Module

Alabama N ——
Alaska B —
Arkansas ST NN
California M N
Colorado N T —
Connecticut ™__" NN
Florida —— —\
Georgia R e
[llinois . i et
The Sparklines Module largely corresponds to our graphomat -

e sparklines component. It visualizes up to ten data series as
"word-sized graphics". As per default, the Sparklines Module

uses the full result set as data input; however, with " 'the bu
tton, a smaller selection can be made. Minimum and
maximum in each sparkline are depicted as red/green dots.
Each individual sparkline is scaled to its own minimum and
maximum; the two grey bars in the background of the
sparklines give orientation aid where the depicted data is
located in the overall data set. In the example above, the

data for Arkansas ist located in the upper third of the result v

set, whereas Alabama and Alaska are located near the
bottom.

Number of Elements This options governs the number of
lines of data that are used to generate sparklines.

The entry in Start Element governs the first element in the
input data to be displayed. If e. g. a 5 is entered, the first
sparkline is generated from the fifth line of data, lines 1 to 4
are left out.

With the option Category Labels, category labels in front of
the sparklines can be toggled on or off.

Suppress sums excludes sums from the data to be displayed.

Data in Rows governs whether the input result set is
interpreted in rows or columns.

Measures

graphomate tiles

4, Sparklines Module

Scripting Options [-1
Displayed Dimensions

dataSet

Mumber of Elements

Start Element
Category Labels
Suppress Sums

Data in Rows

Continent

&
Y

L
<
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Stacked Column Module

South East 200.07m

B — \West 47.13m

Central 147.82m
== North East 22.02m

Summe 417.04m

Use the Stacked Column Module to display a data series as
a stacked chart. The categories displayed correspond to the
selected Displayed Dimensions. Scripting Options 21

Displayed Dimensions

- 6. Stacked Column Module

Column Width, Max. Label Height and Absolute Label Height
work analogous to the Columns or Bar Module.

Measures (¥  Continent w
If the option Graded Colors is activated, the stack elements dataCellLists =
are no longer colored monochrome with white dividing lines, .
but as color gradations of Data Color 1 (defined on the Appea Column Width 30 px
rance Tab). Max. Label Height 30 px
If Negative Stacks is activated, and the connected data Absolute Label Height

series contains negative values, these are sorted to be at the
bottom of the stacked bar. In addition, a small indicator is )
displayed at the baseline. Negative Stacks

Graded Colors

28142


https://graphomate.atlassian.net/wiki/x/H4CCAw

Table Module
Alabama % 316.76k
Alazka 432 50k
Arkansas 113.21m
California 12.37m
Colorado 67517k
Connecticut 2.06m
Florida 4.33m
Georgia 1.79m

The Table Module can be used to display several measures
in a tabular form, either as absolute values or percentage (Val
ue Display).

Color Display governs the text color of the table.

The option Start Element can be used to determine the first
element in the data series to be displayed. Ife.g. a5 s
entered, the table starts with the 5th element in the data
series; elements 1 to 4 are skipped.

Number of Elements narrows the displayed elements to the
number entered.

With Max. Font Size, the maximal font size is determined; up
to this value (in pixels), the text will scale with the tile.

If the options Units or Scaling Factor are active, the table will
show these preceding the first value, provided they are
contained in the data source.

For ease of reading, the option Alternating Background Color
can be used to toggle light-grey bars in the background of
every other line.

w

graphomate tiles

7. Table Module

Scripting Options =1
Displayed Dimensions

Measures

dataCellList
Value Display
Color Display
Start Element

Continent

Number of Elements

Max Font Size
Units
Scaling Factor

x)

Measure

X

W

Text Color z +

1
3

12 px

Alternating Background Color
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Title Module

Net Sales, Arkansas *

Mew Subtitle

The Title Module is text component with either one or two
rows, and an optional icon.

As described above, the metadata from the data source can
be inserted in the text fields with wildcards; alternatively, the
texts can be entered manually.

For bold formatting, the checkbox Bold Titles needs to be
activated.

If the option Absolute Label Height is activated, both lines of
text use the global fontsizes (Appearance Tab). If the option
is deactivated, the text size is scaled down if necessary.

If the checkbox Wrap Titles is activated, texts exceeding the
space limit will be wrapped, resulting in several lines of texts.
Otherwise, they will be abbreviated with "...".

The Icons to be displayed in the right of the module, as well
as their color, can be set either manually or via scripting. To
choose manually, select the desired icon from the dropdown
box. The size of the displayed icons scales with the font sizes
of title and subtitle. These can be set in the Appearance tab.

The field SAPUI5 Icon Id allows to insert an icon of the SAPUI5
library, for example, e00a for a synchronize button. To

display the icon, select SAPUI5 Icon under Icon and copy the
Icon ID into the appropriate field.

In the dropdown box with the label Horizontal Position you
can select how the title should be displayed: either left-
aligned (standard), center-aligned or right-aligned.

© If Absolute Label Height is deactivated, the option Wrap
Title is ignored; also, inline HTML tags will not be
interpreted.

© In the icon explorer, the SAPUIS icon ID could be
shown with a prefix for hexadecimal encoding. The id
needs to be entered without the prefix; please use e. g.
"e00a" instead of "&#xe00a".

graphomate tiles

7. Title Module

Scripting Options [er]
Displayed Dimensions

Measures &  Country & e
dataSingleCell20 san | X
Title Mew Title
Subtitle Mew Subtitle
Bold Titles
Absolute Label Height
Wrap Title
Icon None w
Icon Color Meutral Colc
Custom Color .

SAPUIS Icon Id

Horizontal Position Left w
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Waffle Module

Connecficut, Met Sales

Georgia, Met Sales
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The Waffle Module depicts up to two data series as
segmented stacked bars ("waffles").

The option Values Labels toggles the display of the
underlying values.

With Category Labels, category labels can be toggled on or
off.

Number of Elements This options governs the number of
lines of data that are used to generate waffle bars.

The entry in Start Element governs the first element in the
input data to be displayed. If e. g. a 5 is entered, the first bar

is generated from the fifth line of data, lines 1 to 4 are left out.

Suppress sums excludes sums from the data to be displayed.

The option Axis Alignment governs whether the bars are
aligned with the left component border ("Leftbound"). If
"Center" is chosen, the 0-axis is located in the center; in this
case, the bars will be drawn from the center to the left and to
the right.

With the option Calculation Base, the interpretation of the
input data as either absolute or percentual is determined.

The value Units per Box is only used if "Absolute" is chosen
as Calculation Base. It is used as calculation basis for a
single box in the waffle pattern. If e. g. a value of 4500 is to
be depicted, and 100 is specified as Units per Box, the bar
will contain 45 little squares; an input of 1000 results in 4.5
squares.

The value in Percent per Box is applied if "Percentage” is
chosen as Calculation Base. In this case, the sum of both
data series for each pair of bars is interpreted as 100%; an
input of 1 results in 100 boxes for both series, an input of 5
results in 20 boxes for both series.

graphomate tiles

- &. Waffle Module

Scripting Options [-1
Displayed Dimensions

Measures (% = Continent &

dataCellList15
dataCellList16
Value Labels

+f Category Labels
MNumber of Bars
Start Index
Suppress Sums
Axis Alignment
Calculation Base
Units per Box

Percent per Box

Center
Absolute
1

1
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Appearance Tab

. E— 'y = 1

Font Sizes [ | /’ '/ v = Q

In this section, the font sizes used throughout the Appearance

tiles component can be adjusted. All inputs are in

pixels. Likewise, the font family can be changed Font Sizes

here.
Headlines 18 pi
Regular Text 10 [
Labels 10 px
Font Family Arial w

Padding Padding 10 pix

The padding defined here affects the space Border Size 1 pi

between the border of the overall component and

the modules contained within (blue frame in the

picture on the right). Thus, it also effects the divider

lines between the modules. Individual module

paddings can be adjusted on the General/Layout

tab.

Border Size

This property governs the border size of the

component. If a border size of 0 is specified, no

border will be displayed.

Grid .

f Grid
The option Snap to Grid activates a grid function; if Snap to Grid

checked, the size of the drawing area can only be
changed in the intervals determined in the Grid Size
input field.
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Value Format
Value Format

In this section, the format of all value labels is
determined: ikl Extended

® Basic Percentage Format 0.0%
Here, you can change the presets for absolute

: . Absolute Format 0.0a
and percentage value according to numeral.js.
Locale changes the country setting. If set to AUT Locale en v
0, the country setting will be governed by the Basic Format accarding to numeral js
data source.
® Extended

If a fixed format is desired for the value labels,
this can be done with the extended number
format. The resulting format string can be set

Value Format

via scripting as well. See Number Formatting Basic Baa
abs 4

Decimal Separator , w |, )
Thousands Separator . L v
Megative Sign - w |- w
Scaling 1 w1 W
Decimal Flaces 1 w | 1 w
Prefix

Suffix Uh

Color Configuration Color Configuration

The general color configuration is defined in this Cood . reset
section. In this way, the consistent appearance of

all modules in a given tile is ascertained. Adjustable e . reset
are the colors for Good(positive) and Bad(negative) Text 1 . reset
values, two text colors and two Data colors as well Text 2 B reset
as the color of the Component Border which also

affects the slot divider lines. The Component Data 1 Bl reset
Background fills the entire tile and the color for Hove Data 2 reset
r shows up while hover over the tile. Component Border . -

Component Background reset

Howver reset
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Behavior Tab

|
Scaling | ] /’ ,/

4p
il
0

In this section, the scaling mode can be changed. If Behavior
set to Auto, each module will be scaled according to
the minima and maxima of the selected module;
scaling will usually start at 0. The setting Manual
enables you to enter particular minimum and Auto
maximum values.

Scaling

Manual

If the scaling is set to Auto, the tile can be Comparizon Group

registered in a Comparison Group by activating the m alelc oplelela!H
checkbox. If active, the Comparison Group will

govern scaling; all components within this

comparison group will be scaled identically and an

indicator of the comparison group is shown during

design time.

Within the BIApp, comparison groups are used
globally, i. e. graphomate tables, graphomate charts
and graphomate bulletgraphs which are part of the
same comparison group will be scaled identically.

Note: pie modules are scaled according to their
surface and are not compatible to other modules
and or components within the same Comparison
Group. Therefore It is advisable to use a separate
Comparison Group for tiles containing pie modules.

Flip Effect Flip Effect

In this section, the flip effect of the tile can be : :
configured. m Click | Double Click | Howver

The control element beneath can be used to select
the desired flip action.

Flip Duration governs the animation duration in
milliseconds. If e. g. a 1000 is entered, the
animation will last for one second.

If the flip effect should only be triggered on a
specific module, this can be realized with a small
script in the On Component Selected event:

i f (GRAPHOMATETI LE_1.
get Sel ect edMbdul e() == 1)
{ CRAPHOVATETI LE_1. t oggl eFli p();}
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Server Tab

Server Configuration

Here you can enter the Server URL to which the
component should connect and from which it should
retrieve the templates.

If you have specified the URL to the server, a check
mark indicates that a connection could be
established.

If another server is used later, you can also press
the button next to the Save button and edit the Serv
er URL.

The hyperlink below the buttons allows you to jump
to the admin panel.

Templating Configuration

If the current settings are to be saved as a template,
a new template name can be entered in the input
field with the name Create Template and confirmed
by clicking the Save current State button. If the
naming convention entered is correct, the template
is saved on the server and a toast with the
corresponding message is displayed in the lower
part of the Additional Property Sheet. However, if
the name entered does not meet the expected
naming conventions, a toast with the permitted
characters is displayed accordingly.

Templates stored on the server can be retrieved
and applied via the Template List. Just select the
desired template and press the Apply button. If you
want to delete a template, select the template in the
list and press the Delete button. If changes have
been made to the templates on the server side, the
list must be updated via the Refresh List button.
Changes should then be visible.

See Server Properties.

4p

= /) 7

Server

Server Configuration

Server URL

Save | &

Templating Configuration

Create Template
Name

Save current State

Template List

Apply | Delete | Refresh List

graphomate tiles
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Search Tab
Search Tab . A
i i — /‘ n/ v = Q
At this point you can search for the name, function f—

or group of a property which are displayed at the Ad Search
ditional Properties Sheet. The appropriate settings

are then displayed directly and can be changed Search for Property
here.
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Info Popup and Server Connection Indicator

This section contains information about the installed
version of graphomate tiles as well as a link to a
feedback form on our website.

The Credits contains an overview of the used
libraries.

The icon next to the Info Popup button will indicate
if the connection to the graphomate server is
successful. In this case it will be in green color. Else
it will be grey.

graphomate tiles

grapho il tiles (]
!— [ ] - ' ——

Version 2.1.0.0 Build: 201803061300

Please use this link to submit errors or ideas for
improvement.

The General Terms of Licence and Maintaining of
the graphomate GmbH apply.

© 2018 graphomate GmbH, D-Kiel,
www . graphomate.com

Credits
F more
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Number Formatting

Possible Input for The numeral.js Format String

Number

10000

10000.23

-10000

-0.23

-0.23

0.23

0.23

1230974

1460

1

Number

1.000.234

1000.2

1001

Number

1

-0.43

Source

Format String
'0,0.0000

'0,0"

'0,0.0'

*.00’

'(.00)'
'0.00000
'0.0[0000]'
'0.0a’

IO al

Format String
'$0,0.00'
0,0[.]J00 &

'$ 0,0[.]00"

Format String
0%

‘0 %'

Output
10.000,0000
10

-10.000,0
-,23

(.23)
0,23000
0,23

1,2m

1k

1St

Output
$1.000,23
1.000,20 $

$1.001

Output
100%

-43%

graphomate tiles
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Possible Input for The Extended Number Format String

Percentages and absolute numbers are formatted separately. For this two format strings are used, which follow the
same rules and structure. In general the strings of characters in the format string are simply replaced in the input
number. Exceptions to this rule would be scaling factors and the number of decimal places.

The elements of the format string are separated by the "|" character. Format strings with less than 7 elements (or 6
"|" characters) are considered invalid and therefore ignored. In this case the standard format without scaling and
with one position after the decimal point is used.

The format string consists of the following elements, the ordering is obligatory and cannot be changed:
Negative|Prefix| Thousands|Decimal|Scaling|PointsAfterDecimal|Suffix

N  The prefix for negative numbers. The string "()" will result in the number placed inside parentheses, including
e eventual prefixes and suffixes. If None is used, the absolute number will be shown.
g

at

ive

P A prefixed string of characters, for example a currency symbol or an identifier for the scaling factor.
re

fix

T A separator for thousands.

h

o]

u

S

a

n

ds

D A separator for the decimal places.

e

Ci

m

al

S The scaling factor for the value. This can be given as a whole number or a power, formatted as n"m. A

¢ whole number will be calculated as a power to the basis 10 internally. In case of a given power the value will

al be divided by it directly. Even negative numbers are possible, for example "-3" or "107-3"; in this case the

ing value will get adequately higher. Non numeric inputs are ignored. Please note: given a "0" or a "1" will result
in a scaling factor of 1. The only way to achieve a scaling by 10 is to set the input to "10"1".
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P
oi
nt
S
Af
te
r
D
e
Ci
m
al

S
uf
fix

The number of places after the decimal.

A suffix for the value, analogous to the prefix.

graphomate tiles
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CSS Selectors

Overview of css classes

graphomate tiles

The following illustrations provides some of the css selectors, which can be adressed by using the Costum CSS in

SAP Lumira Designer.

#GRAPHOMATETILE_2_control

.gm_tiles_lineChartValuaText
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